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Logging in
Double clicking on the Consulting Nutritionist icon will launch the program. A
login screen will appear within each of the species folders. With a new version of
the generic program, the log-in name defaults to User Name with no password.
Click on the OK button to login

For corporate versions, contact your support representative for specific user
names and passwords. Login names and passwords may vary across species
folders.

Change the User Name
The User Name and Password can be set by the user within the File Menu. Select
File>Maintain>User Information.
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An Edit User Information box will appear. The name that is displayed on this
screen will be the user’s login name. Therefore, it is important to remember
exactly how you type in your User Name. Additional information can be added
and it can be set to be printed on reports.

Data Location
The data location path located in the lower left-hand corner of the screen indicates
the species folder the program is currently operating in. In the example below,
this program is referencing the Dairy species folder with the specific data path
listed as C:\Program Files\DLX NRC\Data\DairyDD .
Customers, ingredient libraries, and animal models are specific to the species
folder that is indicated in this path. In addition, data restored into the program is
specific to these data paths.
Data paths should also be noted when using Window Explorer to search for
species specific backups or files.

Change Active Customer
When starting the program, you will be presented with a Change Active Customer
window. This screen will display one or more Demo rations or the Customers
that exist within the program. This screen can be accessed at anytime by selecting
the Customer icon in the Toolbar.
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New customers can be added by clicking on the Add button. Customers can be
deleted by clicking on the Delete button. However, you can not be in a customer
that you are trying to delete.
See the Customer Maintenance section to use Assign customers to a folder or to
use the Edit Tree box.

Customer Maintenance
Customers can be assigned into specific folders. These folders are created to assist
you with customer organization only. Folders can be created by clicking on the
Edit Tree box within the Change Active Customer box. This will bring up the
Customer tree box. Within this box, click on Insert and add a caption. This will
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create a new folder to organize the customers. By using the arrows to the left of
the Next button, the folders can be organized in order or by levels.
To move customers into the Customer Folders, return to the Change Active
Customer menu and click Assign.

Single click a customer and release it. Then, drag the customer into the Customer
folder. When the folder is highlighted, release the button to drop the customer
into the folder.
Within the folders, customers can be organized alphabetically or manually. To
change this setting, go to Customized settings by going to Tools>Customize.
Open the View tab.

The Tree View on the left side of this tab will allow the user to change the display
to Alphabetical or User Defined.
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Adding Customer Ingredients
When a customer is created, you will be presented with a screen to select
ingredients from the Master Ingredient Library and put them into the Customer
Ingredient Library. The Customer Ingredient Library can be accessed at any time
by clicking on the Customer Ingredient icon.
Within the Customer Ingredients, there are various tabs. The Select Ingredient tab
will allow users to select ingredients from the Master Ingredient library and bring
them into the Customer Ingredient library.
Ingredients can be added in various ways. The ingredients that are listed can be
filtered by Ingredient Type. The setting for the Ingredient Type that is displayed
is found in a drop down button above the list of ingredients.

6

When the ingredient type is set to ALL, all ingredients will display. By selecting a
different type, on only ingredients from that specific ingredient type will display and
can be selected for the Customer Library.

Ingredients can also be selected from specified Ingredient Selection Lists. See the Lists
section to create these lists.
To move the ingredients into the Customer Ingredient library, select the ingredient and
click the arrow button to move it from the left side to the right. To select multiple
ingredients at one time, hold the control key while individually selecting ingredients.
To select a group of ingredients, select an ingredient and hold the shift key and select
another ingredient. The group of ingredients between the first and last one will be
highlighted and they can be moved over into the customer ingredient library.
Ingredient codes or names can also be entered into the first or second field,
respectively, of the ingredient search boxes. If the ingredient is found within the
Ingredient Type or Ingredient Selection list that is currently being displayed, it will be
highlighted and can be moved over with the arrow.

Customer Ingredient Maintenance
Ingredient Description
Within the Customer Ingredient section of the program, ingredient nutrients,
names, prices, and additional information can be viewed or edited. The Ingredient
Description tab displays the details of individual ingredients which are noted
below. Access or visibility of these features may vary with user licensing.
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Code: Every ingredient has a unique code. These codes can be are alpha-numeric
characters.
Name: Ingredient names are inherited from the Master Ingredient library. These
can be modified as necessary.
O/L: Overlay. If this box is checked, it indicates that the customer ingredient
has “overlay” values. Overlay values indicate that a nutrient value is different in
the customer than that nutrient found for the same ingredient within the Master.
Abbr: Ingredient abbreviations are added or edited within this field. Ingredient
abbreviations are used in the graphing portion of this program.
$/Ton: This field indicates the price for this ingredient. This is normally
defaulted to $/ton. However, changing the price default globally will change this
column and price. See the setups for the Data Control tab to change the default
of this display.
Order: The number in this field determines the ingredient order for those places
where ingredients are set to sort using the User Defined sort order. Values in here
are inherited from the Species ingredient set up, but can be modified for individual
customers.
Type: The Ingredient Type indicates what type a particular ingredient is assigned to.
When it is necessary to change this, put your cursor in the box and a drop-down arrow
will appear with the types that are setup for the ingredients.
Is A Supplement: If this box is checked, the ingredient will appear in a supplement
grid on the ration work screen. Users using the Mix/Unmix feature should not check
this box.
Exclude on Batch Mix: If this box is checked, the ingredient will not be included
with the total calculations of other ingredients for batch mix reports. Ingredients can
also be excluded on the Batch Mix set up parameters
Compute Add-on Costs: Add-on costs are applied to ingredients with this box
checked when these costs are printed on a ration report.
Date: The date field will change automatically when changes are made to an
ingredient or it can be manually changed by the user.
DM Variation: If this box is checked, the ingredient will be included in the dry matter
variation section of a batch mix report regardless of the dry matter inclusions set within
the batch mix set-ups.
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Synch: Ingredients will either be synched to another ingredient or Not-synched. If
the ingredient is synched, it will inherit the nutrients and price of that ingredient to
which it is synched. This is important for those ingredients that are within a mix, but
the main ingredient is controlling the nutrients of that ingredient. More information
on this will be in the Creating a mix section.
Ingredients can be Added and Deleted from this tab. Click ADD to add an ingredient.
A New Ingredient window will appear that allows you to define the necessary detail
information on this ingredient.
To Delete an ingredient, highlight the ingredient on the grid and click DELETE. If
the ration is in use, you will be prompted and you can proceed as necessary.

Analysis
Individual ingredient nutrients can be modified in this section. When you click on this
tab, the default ingredient type is set to ALL. Ingredients within the drop down button

of the Select Ingredient box reference those ingredients that are within the Ingredient
Type that is displayed.
When the ingredient is selected, modifications can be done. The nutrients that are
displayed are controlled by a Nutrient List. If you place your cursor over the Nutrient
List icon, a pop-up will display with the current nutrient list.

By clicking the arrow to the right of the box, a different nutrient list can be selected and
will change the nutrient display of ingredients.
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See the Using Lists section to set the default nutrient list.
To edit the ingredient, place the cursor in the desired nutrient for either the As Fed or
Dry Matter column and key in the new value. The original value that was in the field
will display in the Overlay Value column.
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Several nutrient values are gray. This indicates that a nutrient value is derived from a
calculation of different nutrients. The customized setups will determine if you have
access to change this field. To see the calculation for particular nutrients, go to the
Master Ingredient, Nutrient Description tab.

Analysis All
The Analysis All tab works similarly to the Analysis tab in respect to nutrient lists.

Click on either the AF or DM button to show the nutrients on an As Fed or Dry
Matter basis. Orientation of the grid can be changed by clicking on Nutrient Rows or
Ingredient Rows.

Copy Ingredients
To copy an ingredient, you will first need to add an ingredient using the ADD button
of the Ingredient Description tab. The Ingredient code and name can be entered at
this point. Then, go to the Analysis tab and select a similar ingredient that you will be
copying the analysis of. Click Copy All to copy the nutrient analyses.
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Within the Analysis tab, call up the blank ingredient. The Paste button will be active.

By clicking on Paste, all the nutrients will be copied into the As Fed and Dry Matter
columns. At this point, other nutrients can be edited.
A similar method of copying and pasting can be done by clicking on the box to the left
of each nutrient and selecting it. Additional nutrients can be selected by holding the
control key and selecting other nutrients.

Click Copy Selected and then Paste for the new ingredient and only those nutrients
highlighted will be copied into the analysis.
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Adding Rations
After you have added ingredients to the customer, you will be presented with the
Add/Change Ration Properties screen. This screen will allow you to add or delete
rations or edit the ration information. This section can also be opened by clicking on
the Add/Change/Delete Rations button that is found on the Ration work screen.

To add the ration, click on the Add button. At this point, you can give the ration a
name. Adding a ration code is suggested and will be necessary if rations will be
exported at a later date. (Rations can be given a code during the export process).
There are various choices for the ration type listed in the drop-down menu. These are
helpful to use if suggested nutrients have been set up for the different types of rations.
Analysis basis and units can be changed for individual rations at this screen.
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Balancing Rations
At this point, you will be presented with the Ration Work Screen. The left grid
displays the ingredients that are present in the customer. The right screen displays
the nutrients.
There are two ways that this screen can be utilized for ration balancing. Ingredient
amounts can be manually keyed in the ingredient grid to do a calculated analysis of
ingredient nutrients. Rations can also be balanced by using a least-cost solver that
utilizes the latest animal ration balancing models available within the species folder
that the program version supports.
Information on the particular models that your species or program version
support can be found near the middle of your screen right below the Multiple
Ration tab. The drop down menu will display the different animal model that are
supported in the system. When the model is selected and Animal Specs is clicked,
you will be presented with detailed information on the animal or feeding situations
that the various animal models take into account for the formulations.

Rations sizes can also be selected through this section. In addition to a daily
ration that is formulated to a specific animal intake, rations can be built on a
percent basis (100 lbs As Fed) or a Ton basis (2000 lbs As Fed). However, for
advanced modeling to be functional, the ration size needs to be set to Daily Ration
as this will predict individual animal intake.

Information on particular feeding situations should be a complete as possible for
advanced modeling to accurately match animal performance.
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Ration Optimization
When the Animal Specs screen is completed and the user clicks OK to leave, the ration
will optimize. Rations will optimize using a least-cost solver using any minimum or
maximum restrictions set within the ingredients or nutrients. Restrictions can be
continued to put on the ingredients or nutrients and when the Optimize button is
clicked, a new solution for the ration will be calculated.
If a ration is feasible, no message will display and you may see a series of pink cells.

Pink cells indicate that the solver is hitting a minimum, maximum or ratio
restriction on a particular ingredient or nutrient
If a ration is non-feasible, a red box will appear in the upper left hand corner. You
may see one or more cells that are flagged red.

Red cells indicate that the solver has quit because of something about this field.
The first thing that causes the solver to go non-feasible will result in the entire
ration to be non-feasible; therefore you should assume the entire ration is not
optimized. Ingredients or nutrient conflicts within the parameters of what the
solver is trying to use can cause a ration to go non-feasible.
It is important to note that nutrients not displayed in the displayed nutrient list
may still cause the ration to be non-feasible. Therefore, if you are questioning a
non-feasible ration, you will need to change the nutrient list display by clicking on
the Nutrient list icon and either selecting the <Species List> which displays all
nutrients or the <Required Nuts> which displays only those nutrients that contain
a value in the minimum, maximum, or ratio field.
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Ingredient Grid and Requirements
The left grid on the Ration Work Screen displays the information pertinent to the
ingredients of the ration. For information on adding or deleting columns to this
grid, see the Grid Preferences section.

Hide Unavailable: The Hide Unavailable check box will hide all of those
ingredients that are not available to the ration to use for formulation.
Sub-Rat: This box is only necessary to check for those ingredients that are a subration. Checking this will enable the UnMix box and the sub-ration can be unmixed.
A/U: This indicates if an ingredient is Available or Unavailable. If an ingredient
is available, it is checked and it will be utilized for the ration optimization.
Code: The code indicates the specific ingredient code that is being utilized.
These are maintained in the Master or Customer Ingredient Maintenance section.
Ingredient: This field indicates the ingredient name. These are maintained in the
Master or Customer Ingredient Maintenance section.
SR Item: Ingredients that are checked will be assigned into a mix. Checking this
box will highlight the ingredient field blue and enable the Mix button. See the
Creating a Sub-Ration (Mix) section for more information on this.
Amount: The yellow Amount field indicates the as fed ingredient amount that is
being utilized in a ration. When a ration is either optimized or the analysis has
been manually calculated, the sum of these values will be the same as the As Fed
Weight value that is listed above the ingredient grid.
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DM Amount: This indicates the dry matter amount that it is being utilized for a
ration. The sum of these values will be the same as the Dry Matter Weight value.
$/Ton: The price column displays the price for a given ingredient in the format
that is set within the Data Control options. This price is used for the least cost
optimizer.
Shadow: A shadow price is displayed for ingredients that were not used in a least
cost optimized ration. The shadow price indicates the price the feed ingredient
would need to be in order for it to be utilized in the ration.
Lower Price and Upper Price: The upper and lower prices indicate the upper
and lower price limits of an ingredient that are being utilized for the ration
parameters. If the ingredient price falls below the lower price or rises above the
upper price, the amount of the ingredient that is being utilized in the ration will
change.
Req Type/Minimum/Maximum: These fields work in conjunction to set the
minimum and maximum ingredient constraints. By placing the cursor in the Req
Type field, a drop down menu will appear. The choices to set ingredient
Minimum and Maximums are as fed amount (AF Amt), dry matter amount (DM
Amt), as fed percent (AF %), and dry matter percent (DM %). These settings can

be controlled for individual ingredients. A value that is keyed in the Minimum or
Maximum field will respect the Req Type field and that value will be used as an
ingredient constraint when the ration is optimized.
Min As Fed/Max As Fed: These fields are the original fields that were included
in the Consulting Nutritionist for setting up ingredient constraints. Amounts
placed in this field are restricted on an As Fed Basis only.
Min (DM)/Max (DM): These fields are the original fields that were included in
the Consulting Nutritionist for setting up ingredient constraints. Amounts placed
in this field are restricted on a Dry Matter Basis only.
Ratio Basis/Ratio Min/Ratio Max/Ratio Denominator: These fields work
in conjunction to group two or more ingredients together to balance ratios.
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Placing the cursor in the Ratio Basis field will bring up a drop-down menu that
indicates as fed (AF) or dry matter (DM). The Ratio Min and Ratio Max field can

be set up for two or more ingredients with the desired feeding parameters. If
Ratio Min and Ratio Max are not the same for an ingredient, the ratio will be
allowed to float within the parameters defined.
Placing the cursor in the Ratio Denominator field will bring up the choices of all
the ingredients in the customer library. The ratio denominator should be chosen
as that ingredient that will be fed in the least amount of the ratio group.
In the example below, a ratio is set up for 2 ingredients and locked in at a 2:1
ratio. GrssSil1 is the ratio denominator and will used at one part in the ration.

AF Percent/DM Percent: The values in these fields indicate the amount of the
ingredient that is included in the ration on either a percent of the as fed feed or as
a percent of the feed dry matter.
Ratio 1/Ratio 2: These fields are the original ratio fields that were included in
the Consulting Nutritionist. Ratios set up within these fields are only using As
Fed amounts. Two sets of ratios can be set up by using either the Ratio 1 or Ratio
2 columns.
Ratio 1 (DM)/Ratio 2 (DM): These fields are the original ratio fields that were
included in the Consulting Nutritionist. Ratios set up within these fields are only
using Dry Matter amounts. Two sets of ratios can be set up by using either the
Ratio 1 (DM) or Ratio 2 (DM) columns.
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Nutrient Grid and Requirements
The right grid on the Ration Work Screen displays the information pertinent to
the nutrients of the ration. For information on adding or deleting columns to this
grid, see the Grid Preferences section.

The nutrient requirements of the ration are either displayed on a Dry Matter or As
Fed analysis. The current display is indicated on the gray line at the top of the
grid. The global default display is found in the Data Control tab within the
Customizing options. Individual customers or rations can be defaulted differently
at the customer and ration set-up sections.
The screen can be toggled to display either the dry matter or ration analysis by
clicking on the Analysis Basis icon found at the top of the ration work screen.

While all nutrients that are in a given species are optimized for and calculated
within the ration, for simplicity, they do not all have to be displayed. For this
reason the list of nutrients can change. The nutrients listed are controlled by
which list is defaulted to display at this screen. The default list to display is found
in the Rations tab of the Customized Options section.
To determine which nutrient list is currently displaying on the ration work screen,
use the mouse and hover over the nutrient list icon. A box will pop-up and
display the current nutrient list.
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The list can be changed by clicking on the drop down to the right of the icon.
This will display all the nutrient lists that are available to the user. At this point, a
different list can be selected for display on the Ration Work Screen.
For more information on adding and editing lists, see the List sections of this
manual.
Code: The code indicates the specific nutrient code that is being utilized. These
are maintained in the Master Ingredient, Ingredient Description section.
Name: This field indicates the nutrient name. These are maintained in the Master
Ingredient, Ingredient Description section.
Req Type/Minimum/Maximum: These fields work in conjunction to set the
minimum and maximum nutrient constraints. By placing the cursor in the Req
Type field, a drop down menu will appear. The choices to set ingredient

Minimum and Maximums include amount (Amt), as fed concentration (AF Conc),
dry matter concentration (DM Conc), as fed intake (AF Intake), and dry matter
intake (DM Intake). These settings can be controlled for individual nutrients. A
value that is keyed in the Minimum or Maximum field will respect the Req Type
field and that value will be used as a nutrient constraint when the ration is
optimized.
Conc/Units: The yellow concentration field is the nutrient concentration
calculated for a given ration. There is a Unit field indicating the measurement of
concentration for each nutrient.
Amount/Units: The yellow amount the amount of the nutrient calculated for a
given ration. There is a Unit field indicating the measurement for each nutrient.
Ratio Basis/Ratio Min/Ratio Max/Ratio Denominator: These fields work
in conjunction to group two or more nutrients together to balance ratios.
Placing the cursor in the Ratio Basis field will bring up a drop-down menu that
indicates amount (Amt) or percent (%).
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The Ratio Min and Ratio Max field can be set up for two or more nutrients with
the desired nutrient parameters. If Ratio Min and Ratio Max are not the same for
a nutrient, the ratio will be allowed to float within the parameters defined.
Placing the cursor in the Ratio Denominator field will bring up all of the nutrients.
The ratio denominator should be set to that nutrient that will be fed at the least
amount of the ratio group.

In the example below, a ratio is set up for 2 nutrients and it will be allowed to
fluctuate between a 2:1 and 3:1 ratio. Nutrient number 20, Phosphorus, is the
ratio denominator.
Min (Conc)/Max (Conc): These fields are the original fields that were included
in the Consulting Nutritionist for setting up nutrient constraints. Amounts placed
in this field are restrict a nutrient on a Concentration basis.
Min (amt)/Max (amt): These fields are the original fields for setting up
ingredient constraints that were included in the Consulting Nutritionist. Amounts
placed in this field are restricted on a Dry Matter Basis only.
Sugg. Min/Sugg. Max: These values are entered within the Suggested Nutrient
section of the Species Maintenance section. In many cases they are set up as a
reference only; however, custom packages may be able to set individual suggested
nutrients as a requirement.
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Master Ingredient Maintenance
Ingredients that reside within the Master Feed library are available for any
customer to select, use, and edit. Several of the sections within the Master
Ingredient Maintenance section function the same as the Customer Ingredient
Maintenance section. Additional settings for sections are listed below.

Ingredient Description
Skip Amt?: This setting will only be necessary to use in the data set of a user that is
submitting data for a corporate build. If this box is checked for an ingredient, the
nutrient analysis for a master ingredient with an identical code will not updated when a
corporate update is deployed.

Analysis
Analysis All
The Ingredient Description, Analysis, and Analysis All tab all function the same as
described in the Customer Ingredient Maintenance section. Changes made to these
ingredients will not affect the ingredients of existing customers

Nutrient Description
Detailed information about the nutrients such as the codes, names, and formulas are in
the nutrient description tab.
ID: The nutrient ID is coded within the system and you do not have the availability to
change this value.
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Code: Nutrient codes can be changed if necessary. Use caution so that you do not
have two nutrients of a similar code.
Name: Nutrient names are added or edited within this field.
Abbr: Nutrient abbreviations are added or edited within this field.
abbreviations are used in the graphing portion of this program.

Nutrient

Order: The number in this field determines the order for which the nutrient
displays in the Master or Species nutrient list.
Amount Unit/Concentration Unit: The unit in these fields indicates how the
system is storing the value. To set-up or edit the nutrient display, you should
follow the instructions found in the Species Maintenance section.
Ingr Formula: Formulas for calculated nutrients of individual ingredients are entered
within this cell. The formula references the Nutrient ID.
Ration Formula: Formulas for calculated nutrients referencing the total ration
nutrients are entered within this cell. The formula references the Nutrient ID.
Conv?: Checking the conv? box indicates that the nutrient will convert a value
between and As Fed and Dry Matter concentration. This box should not be checked
for nutrients that are calculated as something other than a dry matter percent (i.e.
percent crude protein).
Neg?: Checking the Neg? box will allow a nutrient to go negative. CA Balance is one
example of this type of nutrient.
Skip Amt?: This is used for calculated nutrients. Checking the Skip Amt field will
skip the calculation of nutrients using as fed values. Instead, it will calculate the
concentration and convert it to and as fed based on the ration dry matter.
Req Type: The Req Type field sets the default requirement for the nutrient to use
when a minimum or maximum is applied at the ration work screen. The value can be
changed on the ration work screen to override the default
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Numerator/Denominator: The numerator and denominator fields are set for
those nutrients that are using two other nutrients to calculate a ratio. By placing
your cursor in either the Numerator or Denominator field, a drop down box will
appear that will have all the nutrients that are available to select.

Ratio Basis: The ratio basis field determines the basis for nutrient ratios set up
using the Numerator and Denominator fields. Placing your cursor in the field will
allow this field to be set up on an Amt or % basis.

Non Linear: The Non-linear box is checked for those nutrients for which the
dynamic models are applied.
Group Flag:

Ingredient Type
Ingredients can be assigned into various categories or types. These types can be
used for sorting ingredients. In addition, security can also be set up by ingredient
type allowing users varying degree of access to these ingredient types.
Access to the Ingredient type section of the program may vary with user levels.
To Add a new ingredient type, click on Add. A screen will appear to add the new
type.
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The ingredient type grid will display a code for this type. It is not necessary to
change this code.
Names of types can be changed at any time by placing the cursor within the Name
field and changing the name.
The order field will determine the sort order of the types within the different
sections of the program where the types are referenced.
To delete a type, place the cursor on the gray box to the left of the desired type
and the row will be highlighted. At this point, click the Delete button.

.

Adding Nutrients
Nutrients can be added to the system. To do this, go to the Master Ingredient
Maintenance section and to the Nutrient Description tab. If there are empty
nutrient slots, these can be used for the new nutrients. (To add Nutrient Slots, go
to the Adding Nutrient Slots section)
The nutrient name can be added into the empty nutrient slot. DO NOT add the
units at this screen. Other items such as the formulas, DM conversion check box
and the Req Type setting can be entered a this time. When this is complete, click
on the Save and Done button in the lower right hand corner. Continue to the
Nutrient Units section.
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Nutrient Units
To associate or change units nutrient units, click on the Species
Maintenance icon.
You will see three tabs. Click on the center tab that reads Species Nutrients.

The left side of the screen displays a drop down box and a Master Nutrient list.

By clicking on the drop down box, the selection will change between the Master
and Species nutrient list. This will control the nutrient list that is on the right grid.
The header above the nutrients will change to reflect this setting and will read
Master Species or a specific species list of nutrients.
Within the Master and the Species nutrient list, find the new nutrient. If the
nutrient is not found in the Species list, it will need to be added. To add the
nutrient, highlight the nutrient on the left and click on the arrow to move it to the
right.
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Set the drop down list on the top to Master. This will change the header on the right
grid to Master Species.Nutrients. To add the units, place the cursor in the Imperial
Amount cell. A drop down will appear. Click on the drop down and the choices of
units will appear. If a unit does not appear on the selection list, it cannot be added.
Repeat this process for the concentration cell in addition to the Metric unit cells.

This process needs to be repeated for the Species list. To do this, return to the drop
down in the upper left hand corner and select the species. This will change the right
grid to the Species Nutrient list. Repeat the process to add the nutrient units.

Adding Nutrient Slots
If no empty nutrient slots are available within the Master Ingredient, Nutrient
Description section, nutrient slots will need to be added to the list.
To do this, click on the Species Maintenance icon.
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You will see three tabs. Click on the center tab that reads Species Nutrients.

The left side of the screen displays a drop down box and a Master Nutrient list.

The left Master Nutrient Side, does not change. By clicking on the drop down
box, the selection will change between a Master and Species.

Select Master. On the left grid, find an empty nutrient and highlight it. Move it to the
right side by clicking on the arrow.

Change the drop list on the top to the species. Repeat the process by moving this
nutrient from this left to the right.
Once the nutrient slots have been added to the system, return to the Adding Nutrients
or Nutrient Units section to add the nutrient names and units.

List Types
Various types of lists are used throughout this program. Users can assign and
order different data to a list. Specific lists can be set as defaults throughout the
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program. In addition, a user can call up different lists to change the display for
different situations.
The different types of lists that are within the program are:
•

Nutrients: Used within the ration work screen, reports, Analysis and
Analysis All tab of the Master and Customer Ingredient Maintenance
section.

•

Ingredients: Used to display the ingredients in the Master and Customer
ingredient screen.

•

Rations: Used to display the rations in the report screen and the ration
selection screen.

•

Ingredient Selection: Used to display the ingredients that can be added
to a ration within the Customer Ingredient – Select Ingredient tab.

•

Batch Mix Ingredients: Used to display the ingredients that are found
on batch mixes.

•

Ration Ingredients:
printouts.

•

Ration Template – Nutrients: Used within the Ration Template section
to control which nutrients are used for building a ration template.

•

Ration Template – Ingredients: Used within the Ration Template
section to control which ingredients are used for building a ration
template.

•

Animal Inputs: Controls which Animal Input factors are displayed on
Model reports, ration reports, and the Multiple Ration screen.

Used to display the ingredients in the ration

Editing an Existing Master List
Lists need to be added or edited within the Master List section before they can be
utilized with these changes in the Customer. Customer lists are can either be the
same as the Master list, or a sub-set of the Master list. Customer lists can also be
ordered differently than the Master list.
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To edit a Master list, go to Tools: Lists: Define Master List.

The Master Lists window will display. The drop down window in the upper left
hand corner will allow you to select a list type to edit.

If a particular list type is selected, the lists within the Select a list to edit drop down
box will only display lists that have been created as this type of list. For example,
if ‘Nutrients’ is the list type selected, only the nutrient lists will be displayed in the
Select a list to edit drop down screen.
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The window displays two different columns of information. The left box has the
data that can be added into particular lists. The right box displays the current list.
Information can be highlighted on the left side and then arrowed over to the right.

In addition, items can be removed from the right side by selecting them and using
the arrow button to move it back to the left side. By clicking on the double arrow,
all items will be moved to or from their respective side.
To order items on the list, highlight the item on the right side. Click the arrow
button up or down to move the item into the appropriate order.

When Master List modifications have been made, click the Save and OK buttons
in the lower left hand corner of the window.

Changes made to the Master list will not go through to existing customer lists
without doing a corporate data update. Existing customer’s need to be brought up
individually and the lists need to be synched to the master list. Go to the
Customer Lists section for this procedure.
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Creating a Master List
Lists need to be added within the Master List section before they can be used in a
Customer. To create a list, go to Tools: Lists: Define Master Lists. Click on the
Details box found in the lower right hand corner. This will bring up a new section
of the window on the right side.

To add a new list, click on the Add button in the lower right hand corner. A
window will appear and the new list name should be entered. Enter the name and
click OK.

In order for the list to be referenced correctly, it is necessary to set the List Type
to the proper category. For this example, we are setting the list type to Nutrients.
At this point, items that can be added to the list are in the left most side of the
window.
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Items that will be added to this new list can be selected individually and then
arrowed over. Multiple items on the left side can also be selected by using either
the shift button or control button and moving the group of nutrients over with
the single arrow. If the double arrow is used, all items will move from the left side
to the right.
List items on the right can be reordered by selecting an item and using the up or
down arrows to move it.

List Properties
Several settings on the list detail section can affect the properties of the list. This
can be modified when lists are being edited or added. To get to this section, go to
to Tools: Lists: Define Master Lists. Click on the Details box found in the lower
right hand corner.
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This will bring up a new section of the window on the right side. There are four
check boxes within this screen that will affect the properties of this list.

Require Complete Customer List: If this is checked, an existing customer can
utilize a list that was edited at the master level. The customer list will still need to
be individually synched to the Master list.
Populate Customer List When Blank: When this is checked, a new master list
will populate customer lists so the list can be used at the customer level.
Lock this list to prevent Updating: This box can be checked when building
lists for corporate use. Lists that have this setting checked will be protected from
being updated with a corporate update. This type of lists enables users to have a
protected list that does not match the data of the corporate default.
Lock this list to prevent Editing: This box can be checked when building lists
for corporate use. Lists that have this setting checked cannot be edited by the user
and can be updated only through corporate updates.

Editing a Customer List
When a list is created at the master level, it can be used within individual
customers. Within each of the customers, there is a specific customer list that
references the master list. The customer list can be the same as the master list or a
sub-set of that list. Items on customer lists can also be ordered differently than
the master list.
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To edit a Customer list, go to Tools: Lists: Define Customer lists.

Just like the Master List section, list types are referenced on the left side of the
window and the specific lists that exist for the customer are on the right side of
the window.

If an item is on the master list, it can be moved from the left to the right to be
placed on the customer list. If an item is on the customer list, it can be removed
by highlighting it on the right and moving it to the left. To order the list, highlight
an item and click on the up and down arrows to move it.
Because all customers can have different lists than those found in the master,
when a change is made to the master list, it is necessary to go into every customer
list and make the change within every customer. By clicking on the double arrow,
the entire list will move from the master list on the left side and onto the customer
list on the right side.
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Using Lists
There are several types of lists that are used throughout the program. This section
will go through each of the lists in greater detail, where they are used, and how
they can be defaulted within the program.
Nutrient Lists
Nutrient lists are used on the ration work screen, the Master and Customer
Ingredient libraries, and reports.

Ration Work Screen. Nutrient lists used in this section are also referenced in the
Ration Optimization section. Lists can be changed by clicking on the drop down
button next to the Nutrient List icon. The default list is set at Tools:Customize..
by clicking on the Rations tab. Within this tab, click on the nutrient list box to set
the default list.

Master and Customer Ingredient Analysis. Nutrient lists used in this section
are also referenced in the Customer Ingredient Maintenance – Analysis tab. Lists
can be changed by clicking on the drop down button next to the Nutrient List
icon. The default list is set at Tools:Customize.. by clicking on the Ingredient
Maintenance tab.
Within this tab, click on the Ingredient Nutrient List box at the lower right hand
corner to set the default list that will appear in the Customer and Master
Ingredient Maintenance section.
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Reports. Nutrient lists are referenced in both the Nutrient Amount and Nutrient
Concentration section of reports. Nutrient lists can also be set on the Reports
printed through the Model Evaluators.
For the ration reports, the list can be changed by going to Reports:Customer
Reports and clicking on the Report Section Info box in the middle of the window.
This Report Section info box can also be accessed at Tools:Customize and then by
clicking on the Print tab. Within this screen, there is a box that reads Report
Section Parameters.

To change
Clicking on this will bring up a window that references the different sections of
the report.
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The Report Section has an Amounts and a Concentration section within the first
column. The second column with the header List name is the reference to which
list each of these sections are using. The list can be changed within the third
column that is the List to Display/Print. Place the cursor within the cell for either
the Amounts or Concentration section. A drop down list will appear and the
nutrient list can be selected. Click OK to save this list setting.

Model Evaluator Reports. Nutrient lists for the Model Evaluator reports are set
within the Evaluation buttons of each of the Models.
Click on the Evaluator button that is found on the Ration Work Screen. There is
a Report tab within this section. .

The different reports and the nutrient lists for these reports are found in the
middle of this window.
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Within some older versions of the program, this list set up may be found within
the Edit Input button of the Evaluator screen. By clicking on the
Edit Input, a Report tab is present and this has the different reports and Nutrient
lists that can be selected.
Ingredient Lists
Ingredient lists control which ingredients are displayed in Master Ingredient
Reports. By going to Reports: Master Reports: Ingredient Nutrient Analysis or
Ingredient Information the ingredients for the Ingredient Lists will appear in the
lower left hand corner. By clicking on the drop down button, the different
Ingredient Lists will appear. On many systems, these ingredient lists may be set
up to be the same as the ingredient types that are found in the system.

By clicking on the Report Section Info box, the default Ingredient list will display.
Another Ingredient list can be selected in the List to Display/Print column. This
Ingredient list will now become the default. The Ingredient Nutrient Analysis and
the Ingredient Information report can be defaulted to different Ingredient lists.

Ration Lists
Ration lists affect the order the ration names appear on the select ration section,
multiple ration screen, and multiple ration reports.
The default Ration list that rations will be assigned to is set within the
Tools:Customize—Rations tab. The Ration List box appears in the Ration List
default box. The default Sub-Ration list that Sub Rations are assigned to is also
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set up on this tab. The names of these ration types is set up within the
Tools:Lists:Define Master Lists section.

Within the Add/Change Ration Properties Window, the list that the ration will be
assigned to is displaying in the Current Ration List box.
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The rations set on the Ration Lists also affect the display on reports. Within the
Report Section Info box, the Ration list is referenced in the first line of the grid.

Changing the order of the rations on these lists will can be done within
Tools:Lists:Define Customer Lists. Rations can be selected on the left drop down
and the actual ration list is selected on the right drop down box. Rations are
displayed on the left box. By highlighting a ration on the right, the arrows can be
used to move it into the desired position.
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Ingredient Selection Lists
Setting up Ingredient Selection Lists allow users the ability to easily select groups
of ingredients from the Master library and move them into the customer library.
To set up an Ingredient Selection List, go to Tools:Lists: Define Master Lists. On
the Select a list type to edit box, choose Ingredient Selection. Within the Select a
list to edit drop down, several blank lists are available for users to access. By
selecting one of these lists, the user can move ingredients from the Master
Ingredients displayed on the left box and over to the right box. By clicking on the
Details box, a third section of the window will appear.

Within the Name field, Users can change the name of Ingredient Selection 1 to a
more descriptive name.
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The Ingredient Selection lists are used in the Customer Ingredient – Ingredient
Selection tab.

Within the upper left hand corner, there is a Select Ingredient List drop down
button. By clicking on this, the Ingredient Selection lists will appear. Select the
desired Ingredient Selection List. This list will appear on the left side. By clicking
on the double arrow, all ingredients will be assigned into the customer.
Ingredients can also be selected individually or by groups and using the single
arrow.

Batch Mix Ingredient Lists
Batch Mix Ingredient Lists control the order that ingredients display on batch mix
reports. The Batch Mix lists are set up within the Tools:Lists:Define Master Lists
section of the program. However, the actual order of the ingredients is controlled
within the individual customers by going to Tools:Lists:Define Customer Lists
section.
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By selecting Batch mix Ingredients on the left, the different batch mix lists will
appear on the right. Ingredients can be highlighted and ordered using the arrows.
The batch mix list that the batch mix report is referencing is found with
Reports:Customer Reports:Batch Mix. A Report Section Info box will appear.
The List Name column of the last row is the batch mix list that is currently being
referenced. The List to Display/Print column contains a drop down box to
enabling the user to change the batch mix list to the one that is set to the desired
order.

Ration Ingredient Lists
Ration Ingredient Lists function in the same way that the Batch Mix ingredient
lists do. Ration reports can be set to custom order by using the button found on
Reports:Customer Reports:Ration Analysis window. A Report Section Info box is
present on this window. The List Name column of the Ingredients row references
how the ingredients are ordered. The List to Display/Print column contains a
drop down box to enabling the user to change the report order list to that which is
set to the desired order.

44

Ration Template-Nutrients and Ration Template-Ingredients
Ration Template-Nutrients and Ration Template-Ingredients are set up the same
was as described within the previous list types. These lists are only necessary to
use for those users who will be setting up templates. Templates are covered
within the building templates section of this document.
Animal Inputs
Animal Input lists are set up and ordered in the same manner as the lists described
in the previous list types. Animal input lists can be displayed on the Multiple
Ration Screen and on reports. These lists can be changed on the Lists:Define
Customer Lists section. The lists available for Multiple Rations are found in the
Multiple Ration Setup section within the upper left hand corner.
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Animal inputs can be printed on reports by going to Reports:Customer
Reports:Ration Analysis and clicking on the Report Section Info button.

Animal inputs are on the last line and the current list name referenced is found in
the List Name column. Lists can be changed by selecting the desired list within
the List to Display/Print column.

Reports
Reports are generated through the system that will print ingredients, nutrients, user
lists, rations, or batch mixes. Ingredients, nutrients and lists can be printed off at either
the Master or Customer level.
To access reports, go to Reports at the top of the screen and then select either
Customer or Master. Within Master or Customer, the types of reports available can be
selected.

For any of these reports, a report window will appear and users can select the items to
print, report details, or change information lists for the reports. These specific reports
will be defined within the Types of Reports section.
Within the report window, a Preview button will appear.
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By clicking on this, the actual report as it will display will appear in a new window.

Printing Reports

Several boxes appear in the upper left hand corner of the preview screen. The number
of pages of the report is present in addition to arrows used to navigate to different
pages. To print the report to your system’s default printer, click on the print button.

Email Reports – PDF generator
To email rations, we suggest using a pdf generator (for a free download, go to
www.primopdf.com). If a pdf generator is already on your system, click on the icon
with the printer and the wrench (the printer setup button). Select the pdf generator
form the Printer Name drop down box. Click OK.

47

Once this has been set up, click on the printer button. Click OK to send this report to
the pdf generator.
The pdf generator information will appear. A Save As box will display with a default
directory and name. Navigate to the desired directory in which you will save this file by
clicking on the box with three dots.

Provide a descriptive name for this file in the File Name field and click Save.

Click OK within the pdf generator program and the document will be created. At this
point, a new window will appear with the report.
To send this file, navigate to this folder using Windows Explorer and attach it to an
email.

Types of Reports
Ingredient Nutrient Analysis Reports
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Ingredient Nutrient Analysis reports can be printed at either the Master or Customer
level. These reports will print out the nutrient analysis for a set of ingredients. To
obtain these reports, go to Reports and then either Customer Reports or Master
Reports. Select Ingredient Nutrient Analysis.

The window for the report information will appear. Ingredients that can be printed
will appear on the left side in the Items to Print section.

Within the Select Report box, you can choose the report setting for a Single or Multiple
report. Multiple Report templates will allow more than one ingredient to appear on a
page.
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The list selection at the lower left hand corner limits the display of ingredients to those
that are assigned to an ingredient list (see Ingredient Lists within the Using Lists
section.) Note that these ingredient lists are not the same as ingredient types that
ingredients are assigned to; however, many systems are set up to have these lists and
types in synch. To see all ingredients, have this set to <Default List>.

By clicking on the Report Section Info box, the sections of the report will display.

The nutrient list can be set up within this section so reports will print only a certain list
of nutrients.
Additional information can be included on these reports by clicking on the appropriate
check boxes on the report information screen.
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Ingredient Information Reports
Ingredient Information reports can be printed at the Master or Customer level. These
reports contain information regarding the names or details of the ingredients. To
obtain these reports, go to Reports and then either Customer Reports or Master
Reports. Select Ingredient Information.

Two types of reports can be selected within this report information screen: Ingredient
Names or Ingredient Details.

A list of ingredients will display in the Select Items to print section.
These reports will print a list of the selected ingredients. Ingredient Detail reports will
provide information on the ingredients that are found within the Ingredient
Description tab of the Ingredient Maintenance section.
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Nutrient Information Reports
Nutrient Information reports can be printed at the Master or Customer level. These
reports contain information regarding the names or details of the nutrients. To obtain
these reports, go to Reports and then either Customer Reports or Master Reports.
Select Nutrient Information.
Two types of reports can be selected within this report information screen: Nutrient
Names or Nutrient Details.

A list of nutrients will display in the Select Items to print section. Nutrient Name
reports will print off the nutrient names of the selected nutrients. Nutrient Detail
reports will print detailed information about the nutrients in the system.

List Reports
List Reports can be printed at the Master or Customer level. These reports contain the
different lists contained within the system and the information on those lists. To
obtain these reports, go to Reports and then either Customer Reports or Master
Reports. Select Lists.
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The lists that are in the system are displayed in the Items to Print box. Selecting a list
and clicking Preview will generate a report that contains the items that are on the list.

Ration Analysis Reports

53

Ration analysis reports can be printed for the rations within each customer. Go to
Reports--Customer Reports--Ration Analysis.

This will bring up the Report Information window. The left side displays the Items to
print which includes the rations and mixes that are in the customer.

The Select Report section contains the different reports that are available within the
system.
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Changing the type of report will change the information displayed within the ingredient
section of the report.
Items can now be selected from within the left box. Other information can be
changed on the report using the other check boxes found from within the Report
Window.

The sections of the report to print and the lists that the nutrient amount and nutrient
concentration sections are displaying are found within the Report Section Info Box.
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